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Overview 
Guide to starting the Right of Way MAP file, working with Data References within a 

Autodesk Docs Project Environment. For creation of all project dwg files, use the 'Civil 

3D 2024 Montana' application to open Autodesk. These workflow notes guide the 

process in using C3D to place linework, for more detail in the design and application of 

placing linework, please review Chapter 23 of the R/W Design Manual. 

Process Provenance 

• Date of development: 11/12/2025 

• Revision date: N/A 

• Application/Tool(s): AutoCAD / Civil 3D 

• Version(s): Civil 3D 2024 

• Environment(s): MDT Civil 3D State Kit r2024 v2.21 

• Contact: Open a Case 

 

References 
Right of Way Design Manual – Chapter 23 

Right-of-Way Placing Proposed R/W Procedure (Need to Link) 

 

https://www.mdt.mt.gov/other/webdata/external/ROW/manual/manlroman023.pdf
https://montana.servicenowservices.com/citizen?id=sc_cat_item&sys_id=13ac75551bc1091049e0ed3ce54bcb3d
https://www.mdt.mt.gov/other/webdata/external/ROW/manual/manlroman023.pdf
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Placing Existing R/W and PLSS Linework 
Section I. Creating the ROMAP File 

Creating the .dwg File 
The ROMAP file will follow the standard naming conventions 

(XXXXX00XROMAP001.dwg). To create a new drawing, select the Civil 3D icon from 

the top left of the application and select 'New'. From the pop-up window, select the 

'design-start.dwt'. Once the file is open, save it immediately in the Autodesk Docs 

project in the RO folder. To save, use 'Ctrl+S' and navigate to the project folder in 

Autodesk Docs. 

Assigning a Coordinate System to .dwg 
Most MDT projects will use the State Plane Coordinate system [NSRS11.MTIF], 

NAD83, 2011 MT International Feet. To assign this coordinate system, the command 

MAPCSASSIGN can be used, or the link to the Map CS Assign dialog box can be found 

in the Start Tool Palette in the State Kit. (Note: To show the coordinate system of the 

drawing in the status bar of your C3D Profile, use the command MAPSTATUSBAR to 

show the coordinate system in the lower status bar ribbon of your screen.) 

Once in the 'Coordinate System - Assign' dialog window, search "MTIF" into the dialog 

box and select 'NSRS11.MTIF'. Click 'Assign' to close the dialog box. 

Attaching Aerial Imagery 
Online Maps 
Once a coordinate system has been assigned to a drawing, navigate to the blue 

'Geolocation' tab in the ribbon. In the Online Maps group, use the dropdown under 'Map 

Off' to select Map (satellite), Map Hybrid (satellite with labels), or Map Roads (labels 

and gray background). 

Geo-Referenced Raster Imagery (Montana State Library NAIP Imagery) 
Set the active layer to X-IMAG-AERI.  From the Insert tab, ArcGIS Group, select 

Autodesk Connector for ArcGIS.   

If an Autodesk Connector For ArcGIS sign in opens, select Access As Guest.  

Navigate to the project location, using the toolbar at the top of the window. Search for a 

nearby town or address. The rectangle with the green background will select the current 

extents of the window, and the rectangle with the blue box will allow a rectangular 

selection. The purple arrow allows the user to upload a polygon to use as the extents of 

the imagery.  

  

Once an area has been selected, use the left pane of the window to search 'Montana 

NAIP 2023' (note, Montana collects aerial imagery on odd years and publishes the data 

one year later. Imagery is roughly 12-18 months behind the current date. As of 5/2024,  
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Geo-Referenced Raster Imagery (Continued) 

NAIP imagery from 2023 is available for the majority of the state, the next imagery 

available will be the NAIP 2025 available for use in mid-2026). 

Scroll through the list and select 'Montana NAIP 2023', another pane will expand. Under 

the 'Layers' group, select the checkmark for the imagery. Click the blue 'Add to my 

design project' button at the bottom left of the screen.   

In the 'Import Layers' dialog window, select 'Import'. In the 'Import Raster data from 

ArcGIS' dialog window, change the Raster Data Folder using the file folder button, 

navigate to the RO folder in ADDocs and create a new folder titled 'RO_Aerial_Photo'. 

Once complete, under the Layer Name/Resolution table, change the resolution of the 

MSDI_Framework_NAIP_2023 to 'Source resolution'. Select Import.  

The image is inserted into the drawing as a clipped raster.  The raster image will come 

in on the current layer and will cover any existing linework or civil objects. To move the 

raster to the back of the drawing order, select the raster border, right click, select 

Display Order and Send to Back.  Once the image has been sent to the back of the 

drawing order, lock the layer by using the Layer Lock command [LAYLCK] found on the 

home tab, layers group. This will prevent selecting or stretching the xref raster while 

operating other commands in the drawing. The raster is an external reference and can 

be unloaded in the external references manager [xref].   
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Section II. Associating the Drawing to the Autodesk Docs 

Project 

Set the Working Folder 
In the 'Toolspace' palette on the Prospector Tab, navigate to the  'Data Shortcuts []', 

right click and select 'Set Working Folder…'. In the dialog box, navigate to the project in 

Autodesk Docs and select the 'Project Files' folder and select 'Select Folder'. 

Set the Data Shortcuts Project Folder 
In the 'Toolspace' palette on the Prospector Tab, navigate to the  'Data Shortcuts []', 

right click and select 'Set Data Shortcuts Project Folder…', verify that the Folder has a 

green checkmark and has the 'XXXXX00X Data Shortcuts' name selected, then click 

'OK'. 

Associate Project to Current Drawing 
In the 'Toolspace' palette on the Prospector Tab, navigate to the  'Data Shortcuts []', 

right click and select 'Associate Project to Current Drawing', verify the working folder is 

the same as the previous step, and click 'OK'. 

 

Section III. Attaching the Retracement Survey 

Attach the XREF 
The Retracement drawing is added via xref into the ROMAP drawing. To add the dwg, 

use the xref manager [xref] or by the 'Insert' tab on the ribbon in the 'References' group 

- 'Attach'. 

In the dialog box, navigate to the SU folder for the project in Autodesk Docs. Select the 

XXXXX00XSUCAD001.dwg and open the file. In the 'Attach External Reference' dialog 

box, verify that the 'Scale', 'Insertion Point', 'Rotation', are unchecked, the 'Reference 

Type' is set to 'Overlay', and the 'Path type' is 'Relative path'. Select 'OK' in the dialog 

box to load the xref into the drawing.  

Inserting an XREF into a Drawing 
From the 'External References' palette, right-click on the Retracement. From the listed 

options, select 'Bind'.  

In the 'BindXrefs/DGN underlays' window, change the menu to 'Insert' and click 'OK'. 

The Retracement is now inserted as a block into the active drawing, breaking all links to 

the source document. To work with the individual elements in the block, select any 

portion of the block in model space and explode the block using the command 

EXPLODE. 
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Purge Block Library 
Once an xref is exploded into a drawing, the block is remembered by the system 

settings. If the linework is removed once the block is bound and exploded into the 

drawing, in order to reference the information in again from the xref manager and 

bind/insert into the drawing, the original block must be purged (removed) from the 

drawing. 

To Purge the Block Library, use the command 'PURGE'.  

In the 'Purge' dialog window, expand 'Blocks' on the list on the left side of the window. 

Navigate to the XXXXX00XSUCAD001 block in the list, select the check mark beside it 

and select 'Purge Checked Items'.  

The System will ask to purge each block selected, unless 'Confirm each item to be 

purged' is unchecked in the 'Options menu'. 
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Section IV. Data Cleanup of the SUCAD File 

Replacing SUCAD Blocks 
Once the SUCAD has been attached and inserted into the drawing, remove any 

unnecessary points, lines, and blocks. Using the Right of Way Tool Palette, replace all 

SUCAD blocks with the appropriate MDT R/W blocks. To access the Right of Way Tool 

Palette, navigate to the 'MDT Tools' tab on the ribbon, in the 'MDT Palettes' group, 

select the 'MDT Palette Groups' dropdown button and select 'MDT Right of Way'. 

Complete PLSS Section Breakdown 
Complete any needed exterior and interior section breakdowns using Chapter 23 of the 

R/W Design Manual. 

 

Change Active Properties for Survey Layers 
Utilize the R/W Layer State (Directions in 818 - Startup Procedure) to update the layer 

properties for the following layers. Once the layer state is active in the ROMAP drawing, 

the following updates are made to the layer attributes: 

Layer Description/Line Color Linetype Lineweight 

VL-ESMT-NHWY-E Existing Non-Highway 
Easement Lines 

White (7) Continuous 0.006 

VL-PLSS-EXTR-E Found Exterior Section Lines Green (3) MDT_Style3 0.008 

VL-PLSS-EXTR-P Unfound Exterior Section Lines White (7) MDT_Style3 0.008 

VL-PLSS-INTR-E Found Interior Section Lines Light Blue (150) MDT_Style3 0.008 

VL-PLSS-INTR-P Unfound Interior Section Lines Orange (30) MDT_Style3 0.008 

VL-PROP-E Property Lines Burnt Orange (20) Continuous 0.006 

VL-RAIL-RWAY-E Railroad Right of Way Lines Dark Blue (132) MDT_Style6 0.006 

VL-RWAY-E Existing R/W Line Dark Orange (32) Continuous 0.006 

VL-RWAY-A Existing R/W Line (Apparent) Purple (202) Continuous 0.006 

 

These properties are automatically overridden utilizing the Right of Way Layer State. 

  

https://www.mdt.mt.gov/other/webdata/external/ROW/manual/manlroman023.pdf
https://www.mdt.mt.gov/other/webdata/external/ROW/manual/manlroman023.pdf
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Section V. Creating Polylines for Existing Highway and 

Railroad Right of Way 

Preface 
The ROMAP drawing is utilized by multiple functional areas across the engineering and 

preconstruction divisions at MDT. For many downline processes in Road Design and 

GIS it is imperative that alignments are created for both existing and proposed right of 

way limits. These alignments are ultimately created in a separate drawing called the 

'ROXSF drawing'. Instructions for the ROXSF drawing are posted under 'Right of Way 

Cross Section Drawing'. The first step of this process is data cleanup and grouping 

within the ROMAP. The following instructions will allow for a simpler and more accurate 

process in the creation of alignments from polylines created from these R/W limits. 

Creating Polylines from Existing Linework 
In the ROMAP drawing, select one of the VL-RWAY-E lines and use the command 

PEDIT [PE]. Since polylines are directional, it is best practice to work from lower 

(beginning) stationing to higher (ending) stationing along the project. Lines from the 

SUCAD survey will typically not be a polyline, most likely the prompt: 'Object selected is 

not a polyline, Do you want to turn it into one? <Y>' will appear. Type 'Y' then Enter. The 

command line will then prompt several choices. The goal of this work is to Join [J] the 

remaining features along the existing R/W linework together. To do this, type 'J' then 

Enter. The prompt will then ask to select objects to join. Select all linework that is 

connected along the original polyline selected. There may be a need to break the 

existing R/W limits into multiple polyline segments at public road intersections where the 

linework is broken. Work from the beginning to the end stations of the alignment on the 

left and right sides of the limits respectively. There can be as little as 2 polyline 

segments that comprise the left and right limits of the EX R/W, but can contain as many 

as necessary to complete the polyline segmentation. 

Known Errors in Polyline Creation 
There are certain line features that are utilized by survey that cannot be made into 

polylines. Splines and certain arcs, for example, will not be added to the polyline 

segments when created. A good check to verify that all the object selected were added 

to the polyline segment is after the command PE is run with the Join subcommand, the 

command bar will alert of how many segments were selected and how many were 

added to the polyline segment. If there are more selected objects than added objects to 

the polyline, additional steps will need to be performed to group all segments into one 

polyline.  
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Through investigation, there are two reasons why objects will not join, one being 

linework that is not connected (endpoint to endpoint) and the other being MicroStation 

converted projects utilizing a non-compliant curve program. 

Endpoint-to-Endpoint Disconnection 
For endpoint-to-endpoint connection object errors, the rectification is to confirm that the 

snap points are endpoint-to-endpoint connected at the break location. If there is a 

surveyed location for the break, relocate the object snap to the break object center 

snap; otherwise use the trim or filet command with a zero radius to force closure of the 

segments. If the relocation of the snap is greater than 0.25", consult the Survey 

department for direction on the location of the true break location. 

MicroStation Conversion Projects - Non-Conforming Arcs 
For non-joining line-arc segment errors, the rectification is to redraw the arc segment 

using the 3-point arc command found in the 'Home' tab of the ribbon, under the 'Draw' 

group, or use the command 'ARC'. To use the 3-point Arc, verify that the object snaps 

'Endpoint' and 'Midpoint' are enabled. Select the beginning of the arc at the endpoint of 

the line segment, then select the midpoint of the existing arc, and finally then select the 

endpoint of the arc at the object snap for the endpoint of the line-arc connection. Verify 

the linework is on the correct layer, then use the [PE], [J] Command again to force 

closure and make the linework a polyline, then delete the original line that is not part of 

the polyline segment from the drawing. 
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Section VI. Adding COS & Boundary Lines from Existing 

Tracts of Record 

Certificate of Survey and Property Ownership Linework 
COS and Property Lines are placed on VL-PROP-E. 

Transparent Commands 
Commands 
For surveys & metes and bounds legal descriptions, the 'Create Line by Bearing' 

Command is an easy way to draw an existing legal description. To use the command 

string [L, enter; 'BD, enter] or from the Home Tab of the ribbon, in the Draw group, use 

the dropdown on the line to select 'Create Line by Bearing'. The ['BD'] is a transparent 

command that is utilized within the [Line] command. There are other types of 

transparent commands including ['SO] for Station/Offset (to an alignment0, ['AD] for 

Angle/Distance, ['ZD] for Azimuth/Distance. All the transparent commands can also be 

found on the 'Transparent' ribbon, under the 'Plan' group. 

Quadrants and Bearings 
Once in a transparent command (e.g. 'BD), you will be prompted to select a quadrant 

and identify a bearing. Quadrants can both be typed and clicked. The quadrants start at 

1 in the NW and ends at 4, clockwise, in the NE.  

Cardinal 
Direction 

Bearing 
Number 

NE 1 

SE 2 

SW 3 

NW 4 

  

Bearings are entered by degrees, minutes, seconds and have two acceptable formats: 

[XXdXX'XX"],[XX.XXXX]. 

For example, if a line has a record bearing of 45°15'30", to assign the bearing you may 

type [45d15'30"] or [45.1530]. 
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Ownership Dots 
Ownership Delineation Dots are used to better denote changes in parcel ownership for 

R/W plans. The level that dots are to be placed are RR-PRCL-BNDY. Ownership dots 

are not annotative by nature and must be placed appropriately based on the scale of a 

project. The offset scale amounts are shown as follows: 

Plan Scale Offset Distance 

1" = 200' 10' 

1" = 100' 5' 

1" = 50' 2.5' 

 

Ownership dots shall be trimmed together at break points along a R/W boundary or a 

property corner. Using the trim [TR] and filet [F] command with a radius of 0' dots may 

be trimmed together. If an ownership dot line is to be broken to trim to two entities 

(common line for two parcels abutting a highway) the Break [BR] command shall be 

used. The Break at a Point [BREAKATPOINT] command breaks a feature at a single 

point, rather than two lines when using the Break command. 

 

Section VII. Placing Existing Access Control Linework 

Preface 
R/W has created a custom palette to streamline Access Control Linework in the 

ROMAP. To access the palette, go to the 'MDT Tools' Tab on the Ribbon, in the 'MDT 

Palettes' group, select the 'MDT Right of Way' palette. There are two tabs in the palette, 

'MDT RW Blocks' and 'Access Control'. On the Access Control Tab of the Palette there 

are 8 buttons to use, 4 for existing AC and 4 for proposed AC. Proposed AC workflow 

notes may be found in Right-of-Way Placing Proposed R/W Procedure. 

The Access Control Palette works with annotation scale set at the time of placement, 

meaning if the scale of a project is 1" = 50', the annotation scale shall be set in model 

space to 1:50 for the placement of the access control linework. Once the linework is 

placed in model space, it will no longer become annotative.  

To best place AC linework, the existing R/W linework should be grouped as a polyline. 
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Access Control ON Existing Right of Way Linework 
To place either EFAC or ELAC on R/W, use the correct button from the AC Palette, 

select the polyline, the command will then ask what side to place the new AC linework, 

select the side closest to the centerline, then hit 'Enter'. 

Note: Be sure to enter out of the command fully, otherwise linework may be overridden 

to incorrect linetypes. 

Access Control OFF Existing Right of Way Linework 
To place either EFAC or ELAC off the R/W Linework, use the appropriate button from 

the AC Palette. The command will enter a line command to draw linework. It may be 

easiest to have points or temporary lines drawn to place the access control lines in 

place using object snaps. Once the linework has been placed, hit 'Enter'.  

Note: The individual lines drawn from the off R/W buttons are not automatically 

converted to polylines. It is best practice to use the Polyline Edit command [PEDIT] to 

convert and join the linework together. To Reverse the Text Placement above/below the 

line created, reverse the polyline direction using [PEDIT] then [R] for reverse direction. 

Note: Be sure to enter out of the command fully, otherwise linework may be overridden 

to incorrect linetypes. 

 

 


